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DPRO3 FM Processore Audio

1

1.1

1.2

Introduzione

Questo apparato realizza un processore audio per impiego broadcast FM completo di coder MPX e
RDS. Il processore € implementato mediante un classico schema a due bande, pit una terza per la
limitazione della preenfasi.

Tale configurazione consente di ottenere comungue un'ottima presenza on air, unita ad una notewole
naturalezza del suono.

L’elaborazione audio e la codifica RDS/MPX sono realizzate tramite DSP, permettendo di avere un
funzionamento stabile nel tempo e la possibilita di implementare nuove funzioni mediante
aggiornamenti software.

Revisioni

1.1.0 17/06/2014 prima edizione

2.0.0 23/09/2014 aggiornamento funzionalita firmware 2.0
2.0.1 20/11/2014 aggiornamento funzionalita firmware 2.1
3.0.0 10/03/2015 aggiornamento funzionalita firmware 3.0
3.1.0 25/01/2016 aggiornamento funzionalita firmware 3.1
3.2.0 14/09/2016 aggiornamento funzionalita firmware 3.2
Avvertenze

Prima di compiere qualunque operazione, attenersi alle norme di sicurezza contenute nel
seguente paragrafo.

Il costruttore declina ogni responsabilita in caso di danni a persone o cose dovuti alla non
osservanza, anche parziale, delle seguenti indicazioni

¢ Accertarsi che la tensione di alimentazione corrisponda a quanto riportato sull’apparato.

¢ Verificare che I'impianto elettrico sia dotato di presa di terra.

¢ Utilizzare solamente prese di corrente dotate di collegamento a terra

¢ Disconnettere I'alimentazione prima di compiere qualsiasi operazione all'interno dell’apparato.

e |l dispositivo di sezionamento dell’apparato € il cawo di alimentazione, pertanto questo deve essere
facilmente accessibile e la presa deve essere posta in prossimita dell'apparato stesso.

¢ Qualungue operazione che comporti I'accesso alle parti interne dell’apparato deve essere
compiuta, dopo la disconnessione di questo dalla rete elettrica, esclusivamente da personale
tecnico qualificato.
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Introduzione 7

1.3

1.4

Pannello frontale

LR
—H\I=Hlﬂlﬂ T

Indicatori presenti sul pannello frontale e manopola rotativa

Presa per cuffia stereo jack 6,3mm (1/4")

e GATE: il led acceso indica che il livello audio € inferiore la soglia di gate
e CLIP: il livello del segnale applicato allingresso analogico & eccessivo.
* DIG IN: lingresso digitale AES/EBU é selezionato come fonte audio

e IP-SDI: l'ingresso streaming ip € selezionato come fonte audio

« AGC: livelli di intervento AGC in ingresso

¢ MULTIBAND LIMITER:livelli di limitazione compressione bande

La navigazione dei menu e modifica dei parametri awiene mediante la manopola.

Pannello posteriore

Con R e
— 0000 .- --00
: () () © © () © © ﬁ; =

VA DIG OUT DIGIN LEFTIN LEFTOUT _ RIGHT OUT RS232 USBDRIVE _LAN

Connettori e regolazioni su pannello posteriore

e DIG OUT (XLR M) uscita AES/EBU

¢ DIG IN (XLR F) ingresso AES/EBU

e LEFTIN (XLR F) ingresso audio analogico sinistro

¢ RIGHT IN (XLR F) ingresso audio analogico destro

e 19K OUT/MPXIN (BNC F) uscita riferimento 19KHz per coder RDS esterno (1Vpp onda

trapezoidale) o ingresso MPX per scambio audio (opzionale)

e MPXOUT (BNC F) uscita composita MPX (+6/-6dBm)

e SCA IN (BNCF) ingresso miscelatore per segnale SCA / RDS esterno (-20dB)

e LEFT OUT (XLR M) uscita analogica canale sinistro

¢ RIGHT OUT (XLR M) uscita analogica canale destro

e CTRL (DSUB 9/25M) connettore controllo GPI (opzionale)

e RS232 (DSUB 9F) connettore controllo RS232

e USB DRIVE (USB-A) connettore disco USB per backup audio (opzionale)

e LAN (RJ45) connettore LAN per controllo o ingresso audio streaming
(opzionale)
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DPRO3 FM Processore Audio

1.5

Navigazione ed editing

La navigazione nei menu e modifica dei parametri awiene mediante la manopola posta sul pannello
frontale. Nel menu principale che appare al termine del caricamento del firmware, € possibile
selezionare i sottomenu relativi alle varie impostazioni.

DPRO
Audio Input

ID: STATION NAME

Premendo la manopola si pud entrare nel sottomenu selezionato.

Una wolta entrati nel sottomenu desiderato, se sono presenti parametri modificabili, si potra
procedere all'editing.

HH Set Input :Digital
Analog lev: @ dB
Dig. lev: ©@.8 dB
Net lev: @.8 dB

Premendo la manopola, apparira un “*” accanto al primo elemento modificabile. L'indicatore non
appare se sulla finestra non sono presenti elementi modificabili

HESet Input:Digital =*
Analog lev: @ dB
Dig. lev: ©B.80 dB
Net lev: B.@ dB

Ruotando la manopola si pud posizionare il cursore *' sugli altri elementi editabili presenti nella
finestra corrente.

HES=t Input :Digital
Analog lev: © % dB
Dig. lev: ©8.8 dB

Net lev: B.8 dB

Volendo ora modificare il livello di uscita del segnale RDS, si prema nuovamente la manopola. Un
simbolo “<” apparira accanto al parametro per indicare che questo € in fase di editing.

© 2023 ITEL Elettronica e Telecominicazioni Snc



Introduzione 9

HES=t Input :Digital
Analog lev: B < dB
Dig. lev: ©.8 dB

Net lev: B.8 dB

Ruotando la manopola si potra ora modificare il parametro selezionato.

HES=t Input :Digital
Analog lev: -6 { dB
Dig. lev: ©.28 dB
Net lev: B.@ dB

Una wlta impostato il valore desiderato, si prema nuovamente la manopola. Il simbolo tornera “*" ad
indicare che si é tornati in modalita di navigazione. Si potranno quindi andare a modificare altri
parametri all'interno della stessa finestra.

HE =t Input :Digital
Analog lev: -6 ¥ dB
Dig. lev: B.@ dB
Net lev: ©0.@8 dB

Se invece le operazioni di editing sono terminate, si prema ancora una wlta la manopola. Il simbolo
“*" scomparira e sara possibile, ruotando la manopola, navigare nelle altre finestre

HESet Input :Digital
Analog lev: -6 dB
Dig. lev: B.8@ dB
Net lev: ©.8 dB

All'interno di qualsiasi sottomenu, una pressione prolungata della manopola causera il ritorno al
menu principale

Audio Input

ID: STATION NAME

Premendo la manopola per 1 secondo apparira la finestra di regolazione del wolume Cuffie.
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2 Funzionalita display

Di seguito vengono riportati i menu disponibili nella versione software attuale.

2.1 Processore Audio
DPROZ2 FM

Audio Processor <

ID: STATION NAME

In questa sezione sono comprese tutte le impostazioni del processore audio.

2.1.1 Livellidicompressione

Nella finestra vengono rappresentati i livelli di compressione/limitazione sulle 3 bande. La stringa
“GTD", se visibile, indica che allo stato corrente il livello audio € inferiore alla soglia di gate.

212 AGC

ON
Agc Rel.Speed:

In questa finestra sono disponibili le impostazioni del controllo automatico di guadagno (AGC) posto
in testa alla catena di elaborazione audio.

Il controllo automatico di guadagno effettua un pre-livellamento del segnale applicato ai compressori/
limiters seguenti, mantenendo pressoché costante il loro punto di lavoro. A lato della barra che
indica il livello di pre-amplificazione applicato al segnale di ingresso, & presente l'indicatore di gate.

Agc Status (On/Off): abilita o disabilita il funzionamento dell' AGC.

Agc Rel.Speed (0..10): velocita di rilascio dellAGC. Incrementando tale valore, si otterra un tempo
di rilascio, inteso come il tempo impiegato dallAGC per aumentare il guadagno in ingresso, piu
breve.

© 2023 ITEL Elettronica e Telecominicazioni Snc



12

DPRO3 FM Processore Audio

2.1.3

2.14

Caricamento preset

N MOD MUSIC HOT
IEI F28 SPEECH OPN

COMPARE

Il campo Onair indica il preset attualmente in onda, mentre nel campo “Try” puo essere specificato
un nuovo preset da caricare. Una wlta selezionato il preset da caricare, si vada sul controllo
“compare” che iniziera a lampeggiare. Ad ogni pressione della manopola, il preset in onda verra
scambiato con il preset in caricamento, permettendone il confronto.

Se e stata attivata la funzione Source Dep.Presets, sara possibile specificare un preset differente
per ogni fonte audio e, alla finestra, verra aggiunta l'indicazione dell'ingresso a cui il preset sara
destinato.

Preset for source:DIG

Bl Fo1l MUSIC HOT

F@8 SPEECH OPN
COMPARE EXIT

E' possibile cambiare fonte audio dall'apposito menu Audio Input .

Se si desiderassero apportare delle modifiche ad uno dei preset di default (Fxx), si effettuino le
modifiche quindi si salvi il preset in una memoria utente (Uxx). Il preset appena salvato diventera il
preset relativo allingresso audio selezionato, o il preset generico, a seconda che sia stata attivata o
meno la funzione "Source Dep.Presets”. Se un preset & stato modificato, verra indicato aggiungendo
il prefisso "MOD" a questo. Il preset cosi modificato sara utilizzabile fino a quando non venga
caricato un nuovo preset e si apportino modifiche a questo.

La modalita FOO:BYPASS, ha come unico parametro modificabile il livello di ingresso e questo &
unico sia per il preset per ingresso Analogico/Digitale, sia per quello NetAudio. Nel caso in cui sia
necessario porre il processore in bypass in entrambi i casi e i livelli di ingresso, dei canali
Analogico/Digitale e NetAudio siano differenti, si potranno compensare le differenze di questi
mediante la regolazione dei livelli di ingresso. Se una delle fonti € il canale Analogico, si consiglia
di impostare, il livello di ingresso del conv. AD, ed utilizzare il livello di ingresso Bypass come
regolazione fine dell'ingresso Analogico. Il livello dell'altro canale, NetAudio o Digitale, potra quindi
essere regolato finemente dal menu di selezione degli ingressi audio.

Salvataggio preset

Curr.Preset Name: EXIT
MUSIC HOT

Store to: SAVE
D:USER @

Curr. Preset name: indica il nome del preset attualmente in onda, la stringa pud essere modificata.
Al termine delle operazioni di editing della stringa, il cursore *' verra posizionato all’estremita destra
di questa e permettera di navigare verso gli altri elementi presenti nella finestra. Una wlta modificato

© 2023 ITEL Elettronica e Telecominicazioni Snc
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2.15

2.15.1

2.1.6

il nome, si scelga quindi una memoria dove salvare il preset e si vada sul controllo “sawe”. Alla
pressione della manopola, il file verra salvato nella posizione specificata.

Regolazione livello gate e drive

Gate:-40 dB GATED
Proc.Drive: 12.0 dB

Input HPF :ON

Gate: la soglia di gate ¢ il livello sotto al quale i tempi di rilascio vengono notewlmente allungati,
permettendo comunque un recupero lento del volume ma evitando di amplificare un eventuale fruscio
di sottofondo durante le pause brewi.

L'indicazione "GATED" risulta usibile se il livello di segnale in ingresso & inferiore alla soglia
impostata.

Drive: indica il livello di amplificazione del segnale in ingresso prima che venga applicato ai
compressori/limitatori, determinando quindi il tasso di compressione a cui sara sottoposto.

Un elevato livello di compressione produrra un suono piu denso e costante, mentre un livello minore
risultera in un suono piu naturale.

Si regoli comunque il controllo drive per avere una compressione di 15 dB circa (regolazione non
critica) in quanto permette una buona omogeneita del livello sonoro su un’ampia gamma di generi
musicali.

Input HPF (ON/OFF): attiva/disattiva filtro passa alto a 30Hz per la riduzione delle componenti
infrasoniche.

Bypass

Bypass Drive: 0.0 dB

Se e stato selezionato il processo "FO0:BYPASS", sara possibile modificare solo il livello di
ingresso e sara visibile la barra di livello di clipping relativo all'ingresso del codificatore stereofonico.
Nessun altro parametro € utilizzato da tale processo, pertanto le finestre di editing verranno
disabilitate.

Regolazione livello di compressione e tempo di rilascio

Compress ion:
Release

Compression:imposta il compromesso fra contenimento della dinamica effettuato mediante
compressione o mediante clipping.

Riducendo il valore di compressione, si otterra un suono di volume pilu elevato, a scapito di maggior
distorsione mentre, aumentando il valore, si otterra un wlume minore ma una maggior purezza del
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2.1.7

2.1.8

suono.
Release:imposta il tempo di rilascio del compressore. Tempi di rilascio minori incrementano il

wlume ma possono risultare in un suono inadatto all’ascolto a lungo termine, mentre con tempi di
rilascio piu lunghi, a fronte di una leggera perdita di volume, si ottiene un suono piu naturale.

Regolazione link ed equalizzazione bande

BandLink : a0 b4
Brilliance: Ll b4

Presence : Z2.0 ciB

BandLink: stabilisce di quanto la compressione della banda dei bassi puo differire rispetto alla
banda dei medio acuti.

Impostando tale valore a zero, il valore di compressione dei bassi sara completamente indipendente
e cio causera anche una sorta di auto- equalizzazione di tale banda fornendo un risultato finale piu
ricco in basse frequenze anche su brani che in origine non ne erano.Impostando invece tale valore a
100%, si imporra che in nessun caso la banda dei bassi possa awere un livello di compressione
inferiore a quella principale e cio si tradurra in un "sound" molto prossimo a quanto applicato in
ingresso.

Brilliance: livello di enfasi della banda sopra a 6KHz

Presence: livello di enfasi della banda attorno a 2KHz

Equalizzatore parametrico toni bassi

BassEqFreq: 65 Hz
BassEqGain: 0.0 dB

BassEq Q: 1.44

BassEqFreq: Imposta la frequenza centrale del filtro parametrico
BassEqGain: Imposta il guadagno del filtro parametrico
BassEq Q: Imposta il fattore di merito (Q) del filtro parametrico.

EqQO0.7 EQ Freq EqQ1.4

Eq Gain

L

© 2023 ITEL Elettronica e Telecominicazioni Snc



Funzionalita display 15

2.1.9

2.1.10

Impostazioni clipper/limiter bassi

Lim Thr: -1.6 dB
Lim Release: 68 X

Clip Thr: -5.8 dB
Clip Softness: 3

In questa finestra & possibile impostare tutte le regolazioni relative al compressore-limiter della
banda dei toni bassi.

Bass lim thr: soglia di internvento del limitatore dei bassi. Aumentando la soglia, si otterra un
controllo dei bassi principalmente mediante clipping, riducendo la soglia si otterra un controllo
principalmente per compressione.

Bass lim release: velocita di rilascio.

La velocita di rilascio della banda dei bassi & regolata in percentuale rispetto alla velocita di rilascio
generale. Un'impostazione del 50%, ad esempio, indica che la banda dei bassi awa un tempo di
rilascio pari a meta del tempo della banda dei medio-acuti. Tempi di rilascio pit brevi aumenteranno
la presenza delle basse frequenze.

Bass clip Thr:soglia di intervento del clipper.

Bass clip softness: selezione curva del clipper.

Il clipper awa una cuna progressivamente piu morbida con I'aumentare del valore. Una curva piu
morbida riduce la distorsione introdotta dal clipping, al contrario un’impostazione a 0, corrispondente
alla curva piu dura, produrra un basso piu ricco di armoniche.

Impostazione stereo expander

Stereo Expander:OFF
Level : B oz

In questa finestra & possibile impostare la regolazione stereo expander.
Stereo EXPANDER ON/OFF: I'effetto stereo expander viene attivato (ON) o escluso (OFF)
Level: livello di espansione.

Benché l'algoritmo di espansione stereo preveda una auto-limitazione dell'effetto, si consiglia
l'ascolto di piu brani al fine di scegliere il livello di espansione piu adatto.
Un'espansione stereofonica esagerata pud aumentare l'interferenza dovuta al multipath.
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16 DPRO3 FM Processore Audio

2.2 Coder RDS

DPRO3 FM
RDS Generator

ID: STATION NAME

In questa sezione sono comprese tutte le impostazioni del coder Rds opzionale.

2.2.1 Livellieflags RDS

RDS: ON LEV:3.0 KHz
TP:OFF TA:OFF RT:OFF

MS:MUS COMPR: ON AH:OFF

RDS(ON/OFF): attiva / disattiva il coder RDS

LEV: impostazione livello di iniezione sottoportante RDS
TP (ON/OFF): impostazione stato flag TP

TA (ON/OFF): impostazione stato flag TA

RT (ON/OFF): attivazione invio radiotext (blocco 2A)

MS (MUS/SPC): impostazione flag MUSIC/SPEECH
COMPR (ON/OFF): attivazione flag "COMPRESSED"
AH (ON/OFF): attivazione flag "ARTIFICIAL HEAD"

Il flag "mono/stereo” verra impostato automaticamente a seconda del tipo di modulazione MPX
selezionato.

2.2.2 CodicePlePTY

PIl:5330
PTY:89 Varied

Pl: Impostazione del codice Pl associato all’emittente
PTY: Program Type, tabella di descrizione del tipo di programmazione effettuato dall’emittente.

Le modifiche diverranno effettive una volta salvate.
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2.2.3

224

225

Monitor PS e Radiotext

PS MON iMY RADIO |
RT MON My Radio My best

radio in town

PS MON: Program Station Name attualmente in onda

RT MON: Indicazione del radiotext attualmente in onda.

Qualora sia attivo il radiotext plus per la stringa radiotext attualmente in onda, verra aggiunto il
simbolo "+" all'etichetta "RT"

Le funzioni Radiotext Plus, PSN dinamico e CT (clock time) sono disponibili utilizzando il software
RD-Link.

Impostazione PS

PS 1 :MY RADIO

Dur(secs): 2 SAVE DEL

In questa finestra e possibile inserire e modificare le stringhe PS che verranno \isualizzate nel
ricevitore, ognuna delle quali pud essere lunga fino a 8 caratteri.

PS 1..24: selezione della stringa da editare.

Dur(secs): tempo di permanenza, in secondi, della stringa attualmente selezionata. Impostando
una durata pari a zero, verra disabilitata la visualizzazione della stringa corrispondente.

SAVE: salva la stringa modificata

DEL: cancellazione della stringa selezionata

Le modifiche dovranno eventualmente essere salvate prima di selezionare una nuova stringa da
editare o prima di uscire dalla finestra, altrimenti verranno perse.

Radiotext

RT 2<{:My Radio My best
radio in town

Durimins): 1 SAVE DEL

In questa finestra e possibile inserire e modificare le stringhe RT, ognuna delle quali pud essere
lunga fino a 64 caratteri.

RT 1..24: selezione della stringa da editare.

Dur(mins): tempo di permanenza, in minuti, della stringa attualmente selezionata. Impostando una
durata pari a zero, verra disabilitata la visualizzazione della stringa corrispondente.

SAVE: salva la stringa modificata
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2.2.6

DEL: cancellazione della stringa selezionata

Le modifiche dovranno eventualmente essere salvate prima di selezionare una nuova stringa da
editare o prima di uscire dalla finestra, altrimenti verranno perse.

Liste AF

AfList: 1 Fregs:14
Freqg #: 1 181.0©

Freq INSERT DELETE
List SAVE CLEAR

Finestra di editing delle frequenze alternative. E' possibile inserire 25 frequenze sulla prima lista per
il metodo "A" o 24 liste per il metodo "B". Per ulteriori dettagli sulle modalita A e B, si faccia
riferimento alla sezione Einestra AF List riguardante il software di programmazione.

AfList 1...24: selezione della lista AF da editare.

Freqgs: indicazione del numero di frequenze presenti nella lista.

Freq #: selezione del numero di frequenza in lista, da 1 a 25, e modifica della frequenza
selezionata.

Freq INSERT: inserimento di una frequenza nella posizione "Freq #" selezionata. Le frequenze
preesistenti in lista verranno spostate di conseguenza.

Freq DELETE: cancellazione della frequenza "Freq #"' selezionata

List SAVE: salva le modifiche

List CLEAR: cancella tutte le frequenze presenti in lista

Note: La lista, una volta modificata, verra utilizzata solo dopo che sia stata salvata mediante il tasto
SAVE. Se verra selezionata una diversa lista (AfList) o si uscira dalla finestra di editing prima che
Sia stata salvata la lista, verranno perse tutte le modifiche. Eventuali frequenze vuote (--.-) presenti
in lista, verranno eliminate automaticamente nel salvataggio.
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2.3 Regolazioniingresso audio

DPRO3 FM
Audio Input

ID: STATION NAME

In questa sezione sono presenti le impostazioni relative agli ingressi audio e alla commutazione
automatica di emergenza.

2.3.1 Regolazione e visualizzazione livelli audio

Nella finestra corrente & possibile visualizzare, con una maggiore precisione, il livello di ingresso del
canale selezionato.

E' possibile selezionare e regolare il livello di qualsiasi canale, ma non verra cambiato il canale
correntemente in onda.
Per cambiare il canale di ingresso, & necessario utilizzare la finestra successiva.

2.3.2 Selezione canale diingresso

Audio input:  Analog, ingresso analogico
Digital, ingresso AES/EBU
Net ingresso da modulo streaming.

Analog lev: livello attenuatore ingresso audio, imposta il livello di ingresso al conwertitore A/D. I
livello nominale € indicato nelle barre:

Set Input :Digital
Analog lev: 9.8 dB

Dig. lev: 0.0 dB
Net lev: .80 dB

La regolazione iniziale dell’'apparato andrebbe fatta in modo che il massimo livello di ingresso
analogico sia uguale o solo leggermente superiore a tale limite.
In nessun caso dovra illuminarsi l'indicatore CLIP posto sul pannello frontale.

Dig. lev: regolazione livello di ingresso digitale AES/EBU
Net lev: regolazione livello ingresso modulo streaming.

La regolazione dei singoli canali é fatta a passi di 0,1dB
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2.3.3

234

Impostazione processo audio

Preset for source:DIG

Gl Fo1 MUSIC HOT

IE F28 SPEECH OPN
COMPARE EXIT

Se e stata attivata la funzione Source Dep.Presets, sara possibile impostare un preset differente per
ogni fonte audio selezionabile nel menu precedente, altrimenti tale finestra non sara visibile. Una
wlta selezionati i presets, questi potranno essere modificati nella sezione Processore Audio.

Si potra assegnare il preset solo alla sorgente correntemente in onda.

Impostazioni fallback (audio backup)

L'apparato pud venir impostato per commutare in onda automaticamente un ingresso ausiliario nel
caso in cui il livello audio dell'ingresso principale risulti inferiore ad una soglia minima.

Fal lback:0FF OnAir:DIG
x [1:ANA AlmTime C:%)

o [12:DIG BackTime:120
o I3:NET AlmThr: -68 dB

Fallback (ON/OFF): attiva / Disattiva lo scambio automatico sul canale di riserva

OnAir: indicazione canale audio attualmente in onda

I1 - 12 - I3: Elenco canali. | canali sono elencati in ordine di priorita, con la massima priorita
assegnata al canale 1.

Qualora un canale a priorita piu alta venga a mancare, verranno attivati i canali a priorita inferiore e
questi rimarranno attivi fino

a quando non torni disponibile un canale a priorita maggiore.

AlmTime: timeout di entrata in allarme

BackTime: timeout di ritorno una wlta cessata la condizione di allarme sul canale principale.
AlmThr: soglia di allarme audio

Se il livello di entrambi i canali L/R della fonte principale sono superiori alla soglia di allarme, questa
verra mantenuta in onda. Quando invece anche un singolo canale risulti inferiore alla soglia,
trascorso il timeout di allarme, verra messa in onda la fonte di backup. Al ripristino della condizione
di corretto funzionamento del canale principale, trascorso il tempo "Back Timeout", questo verra
posto nuovamente in onda.

Nota: le impostazioni verranno applicate una volta usciti dal menu.
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2.4 Regolazioni uscita audio

DPRO3 FM
Audio Output

ID: STATION NAME

In questa sezione sono presenti le impostazioni relative alle uscite audio DIG OUT - L R OUT.

2.4.1 Regolazione livelli di uscita

ANA Out lev 0.0 dBu
DIG Out lev -6.0 dBFS
SEUS

QUT deemph :
Qut pos: Post clipé&Filt

ANA Out lev: livello di uscita audio analogica nei connettori posteriori XLR Left-Right OUT
DIG Out lev: livello di uscita audio digitale nel connettore posteriore XLR DIG OUT
Out deemph: deenfasi applicata all’'uscita (relativo alla sola uscita audio non per l'uscita MPX).
Out pos: punto di acquisizione del segnale audio, pud essere scelto fra:
Post clip&flt: il segnale di uscita & prelevato al termine della catena clipper e filtro 15KHz.
Pre filter: il segnale & prelevato prima del filtro 15KHz e dopo il clipper.
Pre clipper: il segnale & prelevato prima del clipper..

2.5 Regolazioni uscita MPX

DPRO2 FM
MPXx Output

ID: STATION NAME

25.1 Modulazione MPX e impostazione livelllo pilota

Modulation : Stereo
Preemphasis: Sbus
: 5.0 KHz

Pilot Level
Pilot Phase: 8.00 Deg

Modulation (Stereo, Mono L+R, Mono L, Mono R):
Stereo: modulazione stereo
Mono L+R: modulazione mono ottenuta sommando i canali sinistro e destro.
Mono L, Mono R:modulazione mono ottenuta da un singolo canale.
Preemphasis: preenfasi 50/75uS, La preenfasi va impostata secondo le norme tecniche locali.
Pilot level: livello di iniezione del tono pilota a 19KHz.
Pilot Phase: regolazione fase del tono pilota.
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252

2.6

26.1

Impostazioni livello uscita

Audio level : 89 b
Composite lev: 0.8 dBu

Test Tone (Y):0FF

Audio level: percentuale livello audio nel segnale composito.

In un segnale monofonico, privo di sottoportanti pilota e RDS, tale livello puo essere lasciato al 100%
e cio produrra una deviazione di 75KHz. In tutti gli altri casi andrebbe ridotto in base ai livelli di
iniezione delle due sottoportanti, pena la sowamodulazione. Ad esempio, se si desiderasse un livello
RDS di 2KHz e un livello del tono pilota di 6KHz, il livello audio non potra essere maggiore di :

100*(1- ((DevPilot+DevRDS)/75))
che, nel caso sopra descritto, corrispondera a:
100*(1- ((6+2)/75))=89.3%

Composite level: livello di uscita MPX

Test tone (!): se attivato, viene messo in onda un tono di 400Hz, avente livello pari al 100% della
modulazione.

Se le sottoportanti e la percentuale audio sono state regolati correttamente, la modulazione non
superera tale livello.

Impostazioni sistema

DPRO3 FM
System

ID: STATION NAME

Display, Presets Dipendenti, ID stazione

Contrast: 16
Source Dep.Presets:0FF

ID:STATION NAME

Contrast: regolazione contrasto del display.
Source Dep.Presets: abilitazione presets dipendenti dalla fonte audio:

ON: funzione abilitata, verra scelto un differente preset a seconda della fonte audio messa in onda.
OFF: funzione disabilitata, verra utilizzato lo stesso preset, indipendentemente dalla fonte audio
selezionata.

ID: identificativo apparato. E' un'etichetta di 16 caratteri a disposizione dell'utente per identificare
I'apparato.
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2.6.2 GPleopzione Split

76543210
GPI status : DRRDID

Split ctrl port:0OFF
Invert split status:0FF

Mediante questo menu € possibile selezionare remotamente il canale da mettere in onda o gestire
uno splittaggio pubblicitario in uscita MPX (opzionale).
La selezione é possibile tramite scheda GPI, seriale e Network.

GPI status: indica lo stato delle 8 porte disponibili, da 7 a 0.

Split ctrl port: abilita la funzione e seleziona la modalita di comunicazione
OFF: funzione non attiva

GPI: funzione attiva, accetta comandi su porta posteriore CTRL

SER: funzione attiva, accetta comandi su porta seriale RS-232

NET: funzione attiva, accetta comandi da rete LAN.

Invert split status: inverte lo stato di commutazione dell'ingresso MPX
OFF: con nessun comando applicato si € in modalita [SPLITTING]
ON: con nessun comando applicato si & in modalita [NETWORK]

Lo stato di splittaggio viene visualizzato nella parte superiore del display.

In modalita [SPLITTING] in uscita MPX & presente il segnale processato proveniente da Ingressi
Analogico o Digitale o Net Ip stream (se presente).

In modalita [NETWORK] in usicta MPX & presente il segnale applicato a MPX IN.

Connettore posteriore GPI (CTRL)

GPI port status:

0: Pin 6 - Mette in onda il canale ANALOGICO
: Pin 2 - Mette in onda il canale DIGITALE
Pin 7 - Mette in onda il canale NET/IP

Pin 3 - Mette in onda il canale MPX (SPLIT)
Pin 8 - Non usato

Pin 4 - Non usato

Pin 9 - Non usato

: Pin 5 - Non usato

NoahswdbE

DB 9 M

Not Used (5 )
Not Used e Q * Not Used

Not Used
Set MPX Input (SPLIT)- 83 © ottse

0 Set NET/IP Input
Set DIGITAL Input - &2/ (6 B8 - Set ANALOG Input
GND

© 2023 ITEL Elettronica e Telecominicazioni Snc



24

DPRO3 FM Processore Audio

2.6.3

Gli ingressi si attivano mettendo a massa il relativo pin o fornendo una tensione da 5 a 12VDC, in
gquesto caso andranno spostati i jumpers posti sulla scheda all'interno dell'apparato, da posizione
“CLOSE” a“ VIN".

La selezione dei canali tramite porta GPl awiene con priorita esclusiva su un solo canale, se
vengono attivati piu ingressi contemporaneamente \iene ripristinato il canale prima della selezione,
soltanto il canale MPX ha priorita assoluta e ad ogni sua attivazione non tiene conto dello stato degli
altri 3 ingressi portando il segnale MPXIN in MPX OUT.

Esempio 1: e in onda il canale Analogico, viene attivato il pin 2 mettendo in onda il canale Digitale,
nello stesso momento si attiva anche il pin 7 NET/IP, non essendo valida la selezione di due canali
in contemporanea ritorna in onda il canale Analogico.

Esempio 2: € in onda il canale Digitale, viene attivato il pin 6 mettendo in onda il canale Analogico,
nello stesso momento si attiva il pin 3 MPX resta attivo il canale analogico ma l'uscita MPX &
commutata verso MPX IN.

Comandi Network da rete Lan:
Selezionando NET su "Split ctrl port" possono essere inviati comandi via rete lan utilizzando il
protocollo UDP con scheda ethernet standard, il protocollo TCP con scheda opzione IP Streaming.

[AB010103] selezione ingresso analogico
[AB010200] selezione ingresso digitale

[AB010301] selezione ingresso NET/IP

[AB010406] o [AA010100] selezione ingresso MPX
[AB010002] o [AA010001] ritorno al canale principale

Il comando di selezione va inviato completo di parentesi quadre e ripetuto continuamente altrimenti
dopo 10 secondi I'apparato rientra sul canale principale.

Impostazione password

User Password: 1% %1%
Autologout (mins): 3

LOGOUT SAVE

User Password: in questa sezione si pud inserire una password numerica che werra richiesta
all'awio del dispositivo. Impostando "0000" (valore di default) verra disabilitata la richiesta di
password.

Autologout (mins): temporizzazione di blocco automatico. Se non \iene compiuta alcuna
operazione da pannello frontale nell'intervallo specificato, I'apparato si blocchera e sara necessario
reinserire la password per accedere nuovamente.

LOGOUT: blocca immediatamente I'apparato, senza che venga attesa la temporizzazione.

SAVE: salva le modifiche eventualmente apportate alla password o alla durata della temporizzazione
di logout automatico.
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2.6.4 Impostazione Ethernet

IP : 192 168 1 5@
GhY : 2 © © 0

Port : 54000
NetMask: 24 APPLY

IP: indirizzo ip del dispositivo

GWY: indirizzo ip gateway

Port: indirizzo della porta di comunicazione
NetMask: maschera di rete in notazione CIDR.
APPLY: applica le modifiche.

Questa pagina ¢ visibile solo se e stato installato il modulo di comunicazione ethernet.

2.6.5 Info Sistema

Sys: revisione firmware operativo

Proc: revisione firmware processore audio e coder MPX
Hw: revisione hardware

BL: revisione bootloader

SN: numero di serie identificativo dell'apparato.

2.6.6 Opzioni

PURCHASED OPTIONS
%% %1% % %1% %% % %% 5 % 5 5 )

ENTER

Finestra di inserimento del codice di acquisto delle opzioni disponibili.

Inserire il codice per I'opzione desiderata fornito dal costruttore, quindi spostarsi sul controllo ENTER
e premere l'encoder frontale.

L'apparato verifichera il codice inserito e, se questo risulta corretto, attivera l'opzione richiesta.

Esempio per il coder RDS:
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OPTIONS
% % %1% % %1% 1% % % % % %)% % %))

[RDS]
ENTER

2.6.7 Sicurezza

Per proteggere il dispositivo da manomissioni, & possibile abilitare una password di sicurezza

accedendo al menu System, Impostazione password.
All'awio del dispositivo (o trascorso il tempo di autologout) verra quindi mostrata la pagina di login
dowe é richiesto linserimento della password.

Passcode
Ite\h LOGIN

LOGIN: effettua I'accesso ai menu.

Perdita della password: Se la password venisse dimenticata, oltre il 20° tentativo errato, verra
visualizzato un codice di sblocco.
Tale codice dowra essere fornito al senizio clienti per poter recuperare la password.

Passcode
Ite Unlock 330DB3
LOGIN
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2.7 Volume Cuffie

Il Volume cuffie pud essere regolato attraverso la manopola frontale, mantenendo premuta per piu di
un secondo verra visualizzato il menu di regolazione.

Headphone Level
|

Dopo 3 secondi il menu di regolazione si chiudera automaticamente
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3.1

Software di programmazione

Viene fornito a corredo il software Processor Programmer, compatibile con i sistemi operativi a 32 e
64 bits Windows Xp, Windows 7, Windows 8.X, Windows 10 per I'impostazione di tutte le funzioni
del processore audio.

La connessione awiene mediante:

e porta seriale 9600 baud 8N1

e porta ethernet protocollo TCP-IP (Con modulo streaming)
e porta ethernet protocollo UDP

Finestra principale

Nella finestra principale & possibile selezionare il tipo di connessione, tramite porta COM o tramite
porta ethernet utilizzando il protocollo TCP-IP (se presente modulo streaming) o protocollo UDP (se
presente modulo ethernet). Per stabilire la comunicazione, una wlta selezionata la porta, si
connetta il processore al PC e si prema il tasto “Connect”. Se la comunicazione & corretta, |l
programma leggera tutte le impostazioni del dispositivo e informazioni relative al tipo di prodotto,
versione hardware/firmware di questo e il numero seriale.

WP Processor Programmer

P
Pa yde  Processor  System |
y Abort
Caonneckion

Comm Interface

TCP-IF

Serial port: orta di cormunic:

Gek Info

Comim Inke:
s TCP-IP
168

Port: S4000 =

Comen Inkerface

Serial TCP-1P * LDP
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3.2

3.2.1

Processor Params

In questa sezione sono presenti i controlli di processo audio, impostazione delle fonti audio in

ingresso e uscita e parametri di sistema

Presets

In questa pagina vengono Vvisualizzati i livelli di ingresso e di compressione del processore audio e le

varie impostazioni.

Processor Params

OnAir : POWER HIT

Processor Presets

POWER HIT
GC Enabled +

Proc, Drive dB 12,0 % Bass Lim Thr dB
Bass Lim Release %
Bass Clip Thr dB

Compression % B lip Softness

Master Release % Bass EQ dB

Band Link %%

Briliance % 80

Presence dB 2,0 §

Stereo Expander Enabled +

(lower release % value=faster release)

Update

| presets interni all'apparato vengono visualizzati nella finestra apposita e, con un doppio click, &
possibile mettere in onda il preset selezionato. Vengono visualizzati in colore blu i preset di fabbrica,
in colore verde le memorie in cui € possibile salvare i presets modificati dall'utente, in arancio &
visibile un preset eventualmente modificato dall'utente ma non ancora salvato.

BRIGHT
MEDIUM
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Il preset modificato ma non salvato sara utilizzabile fino a quando non venga caricato un nuovo
preset e si apportino modifiche a quest'ultimo.

Sono poi disponibili, nella stessa pagina, le impostazioni del processo audio: per la descrizione
dettagliata dei seguenti parametri, si faccia riferimento alla sezione relativa al processore audio

Processor Drive, Gate Level

AGC Enabled, AGC Speed

Compression, Master Release

Band Link, Brillance, Presence

Bass Lim Thr, Bass Lim Presence, Bass Clip Threshold, Bass Clip Softness
Bass EQ, Bass EQ Q, Bass EQ Freq

Expander Level, Stereo Expander Enabled

Read: esegue la lettura dei parametri impostati

Update: trasferice all'apparato le modifiche effettuate nei parametri di processo audio: modificando
un preset utente o di fabbrica, verra creato il preset temporaneo e abilitato il comando Save Onair
mediante il quale sara possibile, terminate le modifiche, salvare il preset temporaneo in una memoria
utente. Il nome del preset pud essere modificato inserendolo sulla riga superiore

Processor Presets

USER 1

Premendo il tasto Save OnAir si potra scegliere la memoria utente di destinazione.

elect destination preset

Cancel
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3.2.2

Audio Ingresso Uscita

In questa pagina & possibile selezionare gli ingressi, modificare i parametri di uscita, impostare il
backup audio automatico e gestione dei presets dipendenti dalla fonte audio di ingresso selezionata.

Pri sor Params

OnAir : POWER HIT

AUDIO Input-Output

Audio Input  Analoginput ¥  Source dependent pr

Analog In Level dB 0,0 Preset for analog

o — Preset for digital
Digital In Level dB 0,0

Preset for nety

-
POWER. HIT
POWER HIT

POWER. HIT

Bypass In Level dB 0,0

2 NetworkInlevelds 0,0 Analog Cutput Mode Clipped and filtered

-18 Analog OutleveldB 0,0 Analog Output Deemphasis 50uS

t AES Out Level dB 5,0

0" Input 30Hz HPF v
-3 Audio Badkwp Enabled v

Audio Source 1 Analog input Alarm Timeout (S)

Audio Source 2 AESEBU ~ >
Back Timeout (S)

Audio Source 3 AESEBU -

Alarm Threshold (dB)

Update

Nella finstra di sinistra sono \isualizzati i livelli relativi ai canali di ingresso e uscita, il canale
selezionato. L'etichetta del canale attualmente in onda verra evidenziata in verde acceso e la stessa
verra riportata sotto alle barre corrispondenti al livello di uscita.

L'indicazione delle barre di uscita (output) indicano il livello assoluto all'uscita audio e non risentono
quindi delle impostazioni di livello dell'uscita analogica (Analog Out Level) o digitale (AES Out Leel).
Queste ultime quindi corrisponderanno al livello indicato dalle barre solo se i rispettivi valori sono
stati impostati a 0.0dB, altrimenti verranno scalate di conseguenza.

Input 30Hz HPF: attiva/disattiva filtro passa alto a 30Hz per la riduzione delle componenti
infrasoniche.

Per la descrizione dettagliata dei seguenti parametri, si faccia riferimento alla sezione relativa alle
regolazioni ingresso audio, audio backup e regolazione uscita audio.

Audio input: Analog InputLevel, Digital InputLevel, Bypass InputLevel,Network InputLevell

Audio OutputLevel

Audio Backup Enalbled

Source dependents presets

Read: esegue la lettura dei parametri impostati
Update: trasferice al dispositivo le modifiche
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3.2.3 Impostazionidi sistema

In questa pagina € possibile configurare i parametri di rete relatii al modulo ethernet istallato nel
dispositivo.

Connection  Audio/Sys
OnAir : POWER HIT System
DS Enabled v

MET IP
RDS Level KHz 2,0 192 . 168
Pilot Level KHz 6,0 MET MASK

Pilot Phase = 0,00

17 Modulation STEREQ

1z | Preemphasis 50uS
NET PORT 54000 2
t| MPX Qut Level dB

-30| MPx Audio Level %

Update

| parametri di rete mostrati in questa finestra sono attivi quando €& presente il modulo lan standard,
se é stato installato il modulo streaming, la configurazione di rete andra fatta attraverso il webserver
del modulo stesso.

Per la descrizione dettagliata dei seguenti parametri, si faccia riferimento alla sezione relativa alle
regolazioni uscita Mpx e impostazioni sistema

RDS_Enabled, RDS level, Pilot Level, Pilot Phase, Modulation, Preemphasis, MPX Output Level,
MPX Audio Level

NET IP, NET MASK, NET GATEWAY, NET PORT

Read: esegue la lettura dei parametri impostati
Update: trasferice al dispositivo le modifiche
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3.3

Salvataggio - caricamento preset da file

Tutti i preset audio personalizzati dall'utente possono essere salvati in file, questo preset pud essere

trasferito su un altro DPRO o salvato in un drive esterno.

Il software permette il salvataggio e il caricamento di profili audio personalizzati attraverso il menu

File>Processor:

Save Usr Presets to Disk

Apri

Cerca in: |E}Usl Presets V| O ? 0

UISR: 00 AGC+_ dprad
USR 01 LOUD N BASS MOD. dpro3
Documenti | | E|USR 02 BASS LIM+ . dpro3

recenti USR 02 BRILLANCE NOAGC.dprod
USR 02 BRILLANCE UP.dpro3
USR 03 COMPRESS-++.dpro3
Deskiop USR 04 COMPRESS.dpro3
USR 04 STEXP.dpro3
USR 06 BANDLINK 0_ dpro3
USR 06 TEST NEW .dpro3

&

(=)

= 5

S
- ;
’ ERC
ERS

E

Risorse del

computer
". Mome file: | V‘ [ Apri ]
Risorse direte | Tipo file: |DF'F|UE Files "‘ [ Annula ]

il preset in onda verra salvato su disco.

Load Usr Presets to Onair

Load presi

Salvain: |E}Usl Presets v| Q2 =

FRESET TEST.dpra
UISR: 00 AGC+_ dprad
Documenti | | E|USR 01 LOUD N BASS MOD. dpro3
recenti USR 02 BASS LIM+,dpro3
— USR 02 BRILLANCE NOAGC.dprod
[ USR 02 BRILLANCE UP.dpro3
Deskiop USR 03 COMPRESS-++.dpro3
USR 04 COMPRESS.dpro3
USR 04 STERP.dpra3
USR 06 BANDLINK 0_ dpro3
USR 06 TEST NEW .dpro3

&

(=)

= 5

S
- ;
’ ERC
ERS

E

Risorse del
computer

Mome file: VH Salva ]

Risorse direte | Salva come: |DF'F|UE Files "‘ [ Annulla ]

Il preset selezionato verra caricato e messo in onda.
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3.4 Salvataggio - caricamento configurazione di sistema da file

Il software permette il salvataggio e il caricamento di profili di sistema personalizzati attraverso il
menu File>System, questo include tutti i parametri inclusi nelle sezioni "System" e "Audio Input-

Output".

Save System config to Disk

Load Systern Configuration

Save System Ceonfiguration

Salvain | Audio Processor j I‘j‘ E~

=
MNome Tipo Dimensione

| System config mod.dprobsys File DPROGSYS 2KB
| System config.dprobsys File DPROGSYS 2KB

=
i
Risorse recenti

Desktop
Ha‘cct;?ta
Ay
Computer
= %
“w

Rete

4 T | +

Mome file: |System corfig mod.dproGeys j Salva |
Salva come |DPROESYS Files j Annulla

la configurazione di sistema verra salvata su disco.

Load System config from Disk

Load System Configuration

Save System Configuration

Cerca in: | Audio Processor j £ B
= Mome = Tipo Dimensione
s
=¥ [ 5ystem config mod.dprofisys File DPROGSYS 2KB
Risorse recenti - -
|| System config.dprobsys File DPROGSYS 2KB
Deskiop
Ha‘cco?te
L "
Computer
e J
A
Rete
4 1 | [*
MNome file: |System corffig dpro6ays j Apri |
Tipo file: [DPROBSYS Fies =] Annula

la configurazione di sistema verra caricata sul dispositivo.
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3.5

351

RDS

Le pagine di configurazione del modulo RDS saranno visibili se l'opzione RDS é stata attivata.

Finestra flags

Flags
Current Page

Skation ID STATION MAME
Read

Country

"Wrike

+ Enable

all RDS parameters

Program Coder

Abort

In questa finestra sono presenti i parametri di configurazione dell’encoder.
RDS ENABLED: abilitazione coder RDS.

PTY: Program TYpe
Impostazione della tipologia di programmazione effettuata dall' emittente.

PI: Program Identification

Codice identificativo dell’emittente. Il codice & composto da 4 cifre, di cui la prima cifra indica il
paese di provenienza, la seconda indica I'area di copertura e le rimanenti identificano I'emittente
nell’ambito dell’area di copertura.

La prima cifra, per I'ltalia, va impostata a 5.
Per la seconda si scelga, a seconda dell'area senita, uno fra i seguenti codici:

Copertura locale, I'emittente ha un’unica frequenza

Internazionale

Nazionale

Sowra regionale

Ml ||+ |O

.F Codici per emittenti regionali

Prestare molta attenzione alla scelta del codice che identifica la copertura. Se I'emittente possiede
piu di una frequenza dovra necessariamente scegliere un codice di copertura sovraregionale (3) o
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regionale (da 4 a F). L'utilizzo del codice 0 disabilita, in molti ricevitori, la gestione delle frequenze
alternative da parte di questi, in quanto identifica emittenti con un'unica frequenza di emissione. Il
suo utilizzo pertanto va limitato esclusivamente a questo caso.

Le ultime due cifre identificano I'emittente nell’area di copertura e dowanno essere differenti da tutte
le altre emittenti che insistono nello stesso bacino.

Qualche esempio:

5001: emittente italiana (5) a copertura locale (0), codice di programma 01
5202: emittente italiana (5) a copertura nazionale (2), codice di programma 02
54AF: emittente italiana (5) a copertura regionale (4), codice di programma AF

Si rammenta che e particolarmente importante che il codice PI sia unico nell’area di senizio
dell’emittente, in caso contrario si verifichera il cambio di frequenza anche verso I'emittente estranea
che possiede il codice Pl uguale alla propria.

Il codice PI, se gia conosciuto, pud essere inserito direttamente nella casella “Pl Code”, altrimenti si
puo generare scegliendo la nazione da cui viene originato il programma (Country) e la copertura di
guesto (Coverage). Sara infine a cura dell'utente la scelta delle ultime due cifre del codice.

TP: Traffic program
Indica se I'emittente, durante la normale programmazione, trasmette notiziari di traffico.

TA: Traffic Annonunce
Notiziario di traffico in onda. Tale flag dowebbe essere e rimanere attivo durante la trasmissione dei
notiziari di traffico.

MUSIC: Flag che indica se l'emittente & solita trasmettere musica o parlato. Alcuni ricevtori
utilizzano questa informazione per applicare una particolare equalizzazione all'audio o cambiarne il
wlume a seconda del tipo di programma diffuso.

ARTIFICIAL HEAD: Flag che indica che il programma in onda & stato registrato utilizzando una
testa artificiale. Questo dispositivo € appunto una testa umana artificiale con due microfoni posti
esattamente nei condotti auricolari, utilizzata in fase di registrazione di un evento live, al fine di
riprodurne in maniera molto accurata, se riascoltato mediante una cuffia, la spazialita originale.

COMPRESSED: Flag che indica se il programma in onda € stato compresso
STEREOQO: Tale flag viene commutato automaticamente in base al tipo di modulazione scelto.
ENABLE RADIOTEXT: Flag per 'abilitazione della trasmissione del radiotext.

Se disabilitato, non verra trasmesso il blocco RDS tipo 2A.

STATION ID: Nome identificativo del dispositivo, questa stringa di lunghezza max. 16 caratteri, puo
essere assegnata al coder per la sua successiva identificazione e viene \Visualizzata unicamente nel
menu principale dell’apparato.
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35.2 FinestraPS

Conneckion

PS

PS Duration {secs) Current Page

MYRADIO
Read

Read Coder

Prog

Abort

o oo o o o o o o o o o o o o o oo B

In questa finestra & possibile inserire le stringhe PS che verranno \Visualizzate nel ricevitore, ognuna
delle quali pud essere lunga fino a 8 caratteri. Per ogni stringa si pud impostare la durata di
visualizzazione in secondi. Un tempo impostato pari a zero, disabilita la stringa corrispondente.

READ: Pulsante per la lettura di tutte le stringhe PS presenti nel coder. Attenzione: verranno
sovrascritte le stringhe presenti nella griglia del programma.

WRITE: Pulsante per il trasferimento delle stringhe PS nel coder. Attenzione: verranno sovrascritte
le stringhe presenti nella griglia del programma.

WRITE MODIFIED: Vengono trasferite solo le stringhe che sono state modificate
CLEAR SELECTED: Pulsante per la cancellazione delle sole stringhe selezionate nella griglia.

CLEAR ALL: Pulsante per la cancellazione di tutte le stringhe presenti nella griglia.
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3.5.3 Finestraradiotext

RDS Generakaor
RadioText

RadioText Duration {mins}) Current Page

My Radio, best skakion in bovn 1

Read

¥es, it is really the best

Wiribe Modified

Clear

Clear all

all RDS parameters

Program Coder

Abort

In questa finestra & possibile inserire le stringhe radiotext , ognuna delle quali pud essere lunga fino
a 64 caratteri. Per ogni stringa si pud impostare la durata di visualizzazione in minuti. Un tempo
impostato pari a zero, disabilita la stringa corrispondente.

READ: Pulsante per la lettura di tutte le stringhe radiotext presenti nel coder.Attenzione: verranno
sovrascritte le stringhe presenti nella griglia del programma.

WRITE: Pulsante per il trasferimento delle stringhe radiotext nel coder.Attenzione: verranno
sovrascritte le stringhe presenti nel coder.

WRITE MODIFIED: Vengono trasferite solo le stringhe radiotext che sono state modificate, in
questo caso la stringa RT2 che & marcata dall'indicatore rosso come modificata.

CLEAR SELECTED: Pulsante per la cancellazione delle sole stringhe selezionate nella griglia.
CLEAR ALL: Pulsante per la cancellazione di tutte le stringhe presenti nella griglia.
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Finestra AF List

Flags AFList
Freq Info ~ aflist1

AF 1 101.0 —
AF 2 104.4 Aflist2
AF 3 104.5 Af list 3
AF 4

Af list4
AF 5

Current

AF B Af list 5
AF 7

Af list6
AF &
AF 9 Af list7
AF 10 ]

Af list8
AF 11
AF 12 Af list g
AF 13 Af list 10
AF 14 P Zod

. 'rograrn Coder

= Af list 11
AF 16 Af list 12 Abort;
AF 17
lagge | @ ""/}&| Af list 13

L'encoder RDS permette linserimento di frequenze sia con metodo "A", sia con metodo "B". La
scelta fra i due metodi dipende dalla struttura della rete e dal numero di frequenze alternative
presenti. Non esiste un flag che indichi al ricevitore se le tabelle di frequenze alternative sono
trasmesse mediante metodo "A" o "B", la differenza fra i due metodi infatti & nella disposizione delle
frequenze nelle tabelle.

Nota: non e possibile compilare liste diverse utilizzando il metodo A e B contemporaneamente. Il
metodo A va utilizzato solo quando la rete possiede un massimo di 25 frequenze e non fa
programmazione differenziata a livello regionale. 1l metodo B va invece utilizzato quando le
frequenze alternative sono superiori a 25 oppure quando, allinterno della stessa rete, awiene la
diffusione di programmi regionali, ad esempio notiziari locali, solo su alcune frequenze. Le liste
vanno compilate partendo dalla prima e vanno riempite non lasciando liste vuote: le liste successive
alla prima lista vuota non verranno trasmesse.
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3.54.1

3.5.4.2

Editing

Af list1 Current Page

Af list2 Read

Clear lisk Af list 3
Sort Frequencies
Build B List
Insert

w'rike

Af list4

Af list 5
Rermone

Af list6

Af list7
Clear all

Af list 8
all RDS parameters

Af listg

Af list 10

AF list 11 Program Coder

Af list 12 Abort

Af list 13

Nel menu popup richiamabile mediante il tasto destro del mouse, vi sono i principali strumenti per la
compilazione della lista.

Clear list: Cancella la sola lista corrente

Sort Frequencies: Ordina tutte le frequenze inserite in maniera ascendente

Build B List:

Insert: Inserisce una nuova frequenza nel punto richiesto e sposta in basso le altre frequenze
presenti in lista.

Remove: Rimuowe la frequenza selezionata.

Metodo A

Questo metodo ¢ il pil semplice ed é indicato per tutte quelle emittenti che abbiano un massimo di
25 frequenze alternative e che non facciano programmi differenziati su base regionale.

Per implementare tale metodo, & sufficiente inserire nella lista AF list 1 tutte le frequenze
dell’emittente in ordine crescente.

Esempio:
88.5
91.3
104.1
104.5
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Metodo B

Questo metodo € indicato qualora I'emittente abbia piu di 25 frequenze alternative o qualora
un'emittente pluriregionale o nazionale, in differenti momenti della giornata, diffonda programmi
regionali differenziati. In questo metodo, il numero di liste occupate & uguale al numero di ripetitori
presenti, per cui viene diffusa la frequenza capolista di ogni ripetitore e tutte le sue possibili
alternative. Ogni frequenza alternativa viene trasmessa sempre in coppia con la frequenza capolista
a cui appartiene; l'ordine della coppia capolista-alternativa definisce se quella particolare frequenza
alternativa € una variante regionale della frequenza capolista. Ogni lista inizia con la frequenza
capolista, seguita da 12 coppie capolista-alternativa; qualora le frequenze alternative fossero
maggiori di 12 per la stessa capolista, sara possibile utilizzare due o piu liste. Se invece una stessa
frequenza capolista viene utilizzata piu di una wolta nella rete, la lista delle frequenze alternative
andra separata mediante una lista avente una diversa capolista in modo che il ricevitore non associ
erroneamente le frequenze alternative alla stessa capolista. Le coppie capolista-alternativa vengono
generalmente trasmesse in ordine crescente qualora la frequenza alternativa trasmetta in ogni
momento della giornata la stessa programmazione della frequenza capolista.

L'ordine decrescente & invece utilizzato per indicare che la frequenza alternativa € una variante
regionale della capolista, pertanto, in diversi momenti della giornata, potrebbe trasmettere una
diversa programmazione.

Per semplificare la programmazione di una lista B, si ponga, come prima frequenza, la frequenza
capolista, a seguire tutte le frequenze alternative (max. 12) e si prema il pulsante “Build B list”. Se si
desiderasse a questo punto aggiungere una nuova frequenza alternativa, la si inserisca in coda alla
lista appena compilata e si prema nuovamente il pulsante “Build B list”.

AFList
Freq Info = AF list 1 Current Page
AF 1 Q0.0
AF 2 104.5 Aflist2
AF 3 93.5 Af list 3 .
‘wirite

AF 4 105.2

Af list4
AF 5 106.7

Wirite Current

AF & 104.9 Af lists
AF 7

Af list6
AF &
AF 9 Af list7

Clear ol

AF 10

Af listd
AF 11 &ll RDS parame
AF 12 Af listg
AF 13 Af list 10
AF 14
" Af list 11
AF 16 Af list 12 Abork
AF 17
laggn | @/ Af list 13

Le frequenze sono state immesse, inserendo come prima frequenza la capolista.
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Flags AFList
Freq Info ) AF list 1 Current Page

AF 1 Q0.0 Main Freq —
AF 2 90.0 Main Freq Aflist2
AF 3 93.5 Af list 3
AF 4 Q0.0 Main Freq

Af list4
AF 5 104.5

Wirite Current

AF 6 20.0 Main Freq Af lists
AF 7 104.9

Af list6
AF 8 Q0.0 Main Freq
AF 9 105.2 Af list7
AF 10 Q0.0 Main Freq .

Af listd
AF 11 106.7
AF 12 Af list 9
LA A list 10
AF 14
AF 15 Af list 11
AF 16 Af list 12 Abork
AF 17
Sekia w || AF list 13

Premendo il tasto “Build B List”, si ottiene la lista compilata con metodo “B”.
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3.5.5 Salvataggio - caricamento profili da file

Il software permette il salvataggio e il richiamo di profili da file precedentemente salvati attraverso il
menu File>RDS:

Load Configuration

Load Configuration

Configuration

Cercain | 23 Ust Presets v| €] 5 S
) Rds 02_2015 rds
{ Rds 10_27014 rds
Documenti Rds Stationl .rds
recenti Rds Station2.rds
=
L
Desktop
Drocumenti
Risorse del
computer
" Marme file: V| I Apri I
Risorse direte | Tipo file: |F|DS Files v | [ Annulla ]

Save Configuration

Salva con nome E]
Salvain | 129 Usr Presets v | QF -
Y Rels 02_2015.rds
i Rds 10_2014 rds
Documenti Rds Stationl .rds
recenti Rds Stationz.rds
?"_‘
L
Desktap
Drocumenti
Risorse del
computer
" Mome file: F:d::: ( = | I Salva I
Risorse direte | Salva come: |F|DS Files v| [ Annulla ]

In questo modo € possibile salvare su disco tutti i dati relativ al coder rds in un file con estensione
.rds, questo file pud essere caricato nel dispositivo con la successiva procedura "Load
Configuration".
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3.6

Impostazione Password

MultiBand Processor Prograrmm

. 188 . . Disconnect -

54000 -

Get Info

Se lo si desidera & possibile proteggere I'apparato mediante un codice numerico di accesso. |l
codice di default & 0000 (disabilitato), ma € possibile cambiarlo tramite la procedura descritta in
seguito:

Change Passcode: permette di modificare la password di accesso al dispositivo.
Digitare la password corrente, 0 0000 se nessuna password € attiva, nell'editor "Passcode", la nuova
password nell'editor "NewCode" e, nuovamente, in "NewCodeConfirm" .
Selezionare quindi il menu PassCode>Change PassCode per awiare la procedura.
Warning

r] This procedure will change your current pass
% Really continue?

Store Password to disk: salva la password nel file di inizializzazione del programma in modo da
non dowerla digitare ad ogni connessione.

Change

Sko
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4

4.1

RD Link

Il software RD-Link permette la connessione del coder RDS al sistema di automazione radiofonica
per poter sfruttare le funzionalitd Radiotext Plus, TA e Clock-Time. Al momento della redazione del
presente documento, il software risulta gia compatibile con alcuni sistemi di automazione
radiofonica, ma ulteriori interfacce possono essere inserite su richiesta del cliente in modo da poter
estendere la compatibilita verso altri sistemi.

® RD-Link ¥:2.0.0.0 Raw text

File Tools

Artist-Title

Filetame: :\Documents and Settings)DeskboptRT-+Hoest, bt

Arkisk
SHAKIRA

a Tartura

03/03/15 09,40.41 RT+:5HAKIRA La Tortura

Radiotext Plus

Il radiotext plus & un senizio che, unitamente al radiotext classico, consente di contrassegnarne
parti specifiche in modo che queste possano venir isolate e utilizzate dai ricevitori predisposti. Sara
quindi possibile, ad esempio, poter disporre della playlist dell’emittente con i nomi degli artisti e i
titoli dei brani andati in onda.

Un esempio della funzionalita Radiotext (RT) con Radiotext plus (RT+)

Nel radiotext viene trasmessa la stringa seguente: "SHAKIRA - La tortura"

Un ricevitore predisposto per la decodifica del Radiotext Plus potra prendere solo alcune parti
dell'intero testo trasmesso.
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4.2 Monitor

® RD-Link ¥:2.0.0.0 Raw text

File Tools

Artist-Tile | Monitor

i:I3,I'I33,I'15 09.49.58 RT+:3HAKIRA La tortura

Nella finestra Monitor viene data una rappresentazione di quanto verra trasmesso nel PSN e nel
Radiotext, lo stato dei flags TA, CT e RT+ e dello schedulatore.

TA Arancio : flag TA attivato per notiziario di traffico in onda
Grigio: flag TA disattivato

CT Verde:viene inviato il blocco 4A corrispondente all"ora/data di sistema
Grigio: il CT é disattivato.

RT+ Blu: la stringa attualmente \Visualizzata é stata associata a Radiotext Plus.
Grigio: Radiotext Plus disattivato.

SCHED Verde:schedulatore attivo, invio Radiotext Plus abilitato
Rosso:schedulatore attivo, invio Radiotext Plus disabilitato
Grigio: schedulatore disattivato, invio Radiotext plus dipendente
dall'impostazione del flag Enable RT
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4.3

43.1

43.1.1

4.3.1.2

Configurazione

Aprire il menu di configurazione (Tools->Configuration), apparira la finestra seguente:

stai ascolkando
B [ addoffset w0 o

o

Setup

Program ID

E' possibile assegnare un nome alla finestra del file eseguibile in modo da riconoscerla rapidamente
in caso Vi fossero pit eseguibili in funzione contemporaneamente per il controllo di diversi coder (es:
pit emittenti facenti capo ad uno stesso gruppo editoriale).

Radiotext Plus e PSN dinamico

Enable RT+: abilitazione radiotext +

Le stringhe ricewte dall'automazione radiofonica verranno effettivamente passate al radiotext solo se
questo flag € attivo. Si potra inoltre aggiungere un prefisso e un separatore alle stringhe poste in
onda. Si ricorda che la lunghezza massima di una stringa radiotext in blocco 2A & di 64 caratteri. Se
la lunghezza totale della stringa, inclusi il separatore e il prefisso, fosse maggiore di questo limite,
verra automaticamente troncata.

Send RT+ titles to PSN: abilitazione invio titoli radiotext su PSN.
Abilitando tale funzione, i titoli verranno inviati anche sul PSN (gli 8 caratteri visualizzati in ogni
ricevitore dotato di RDS). Tale funzione va usata con cautela in quanto pud causare la distrazione
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4.3.1.3

del conducente e in alcuni paesi € espressamente vietata. Si consiglia quindi di controllare le
normative in materia prima di attivarla.

Per questo motivo € stato ridotto al minimo lo scroll a singolo carattere, in quanto il programma
cerca di trasmettere principalmente interi blocchi di 8 caratteri .

Separator; separatore da inserire fra titolo e artista. Si pud scegliere un separatore differente
rispetto al radiotext.

Scroll Interval (Secs): durata dello scroll a carattere singolo.
Tutte le stringhe che non entrano in 8 caratteri, verranno visualizzate scorrendo un carattere alla
wlta utilizzando questo intervallo.

Word Interval (Secs): tempo di visualizzazione della singola parola.
Una parola che ha una lunghezza pari o inferiore a 8 caratteri, verra visualizzata intera e mantenuta
per il tempo selezionato.

Repeat Delay (S) : Il titolo verra nuovamente visualizzato sul display PSN, trascorso tale tempo (in
secondi). Inserendo un valore 0, il titolo verra visualizzato solo all'inizio del nuovo brano e quindi il
coder tornera alle stringhe PSN memorizzate internamente fino al prossimo brano in onda.

End title blank duration (Secs): se impostato diverso da 0, verra trasmesso un PSN wuoto per la
durata selezionata fra la fine della visualizzazione del titolo/artista e l'inizio della visualizzazione delle
stringhe PSN interne.

Sync start DyPSN: se abilitato, fara partire il PSN dinamico solo alla fine delle stringhe PSN
memorizzate internamente.

Restart from first PSN item after DyPs: se abilitato, fara ripartire la visualizzazione delle stringhe
PSN interne dalla prima.

TA - Clock time

Enable TA: invio comando accensione Flag TA durante notiziari di traffico.

Max duration: durata massima del comunicato di traffico. Trascorso tale tempo, se nel frattempo
non erra ricewto un apposito comando di disattivazione, il flag TA werra disattivato
automaticamente.

TA Trigger string: specifica una stringa che, associata al titolo o artista relativo al notiziario di
traffico, permette al programma di sapere quando questo viene posto in onda, attivando
conseguentemente il flag TA.

Hide traffic title string on radiotext: se abilitato, non fard \isualizzare la stringa associata al
notiziario di traffico né sul radiotext, né sul PSN.

Enable CT: invio blocco CT (clock time).

Attivando tale funzione, verra inviato automaticamente il blocco 4A per la sincronizzazione o
visualizzazione dell'orario corrente. Essendo trasmesso l'orario di sistema, si raccomanda di
mantenere sincronizzato il PC mediante un time sener.

Se il PC dovesse spegnersi o interrompersi la comunicazione fra PC e coder, la trasmissione del
blocco 4A verra sospesa.

Add offset: per aggiungere un offset all'orario correntemente trasmesso.
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Interfaccia di comunicazione e impostazioni aggiuntive

Max RT+ Duration (mins): massima durata di una stringa radiotext.

Tale controllo specifica un tempo massimo di visualizzazione per le stringhe Radiotext Plus, facendo
poi tornare automaticamente il coder alle stringhe Radiotext memorizzate internamente, qualora
questo tempo dovesse venir superato. E'stato inserito per evitare, in caso di problemi sul sistema di
automazione o sul collegamento fra PC e coder, che rimanga visualizzata permanentemente I'ultima
stringa Radiotext Plus trasmessa.

Show log: visualizzazione del log delle attivita del programma.

Center PSN: giustifica al centro le stringhe visualizzate sul PSN, se di lunghezza inferiore agli 8
caratteri.

Use scheduler for dynamic contents: attiva lo schedulatore se si desidera utilizzare le funzioni di
radiotext plus e PSN dinamico solo in alcuni orari o alcuni giorni della settimana.

Create a copy of RDS file: crea una copia identica del file contenente i titoli perché questo possa
venir utilizzato da altri programmi (es: streaming encoders).

Save log: salva l'attivita del programma in un file di log tipo "log_10-03-2015.txt"

Coder interface: selezione interfaccia RS232, TCP/IP o UDP.
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4.3.2

Raw Text Importer

Il raw text importer permette di configurare limportazione di normali files di testo.

La tortura ; SHAKIRA

0y La kortura
1: SHAKIRA

1 4 SHAKIRA
0 4 % | |La tortura
i
o

Il contenuto del file attualmente selezionato (dalla finestra principale File->Raw TextFile) viene
visualizzato nella casella Raw Text Input.

| campi possono venire separati in due modi:

utilizzando i separatori: la stringhe lette dal file verranno divise utilizzando i caratteri inseriti
nell'editor "Separators".

Nell'esempio superiore, la stringa in ingresso (raw text input) "SHAKIRA;La tortura" viene divisa,
utilizzando il separatore ";".

Cio produrra due linee in uscita (linea 0: La tortura, linea 1:SHAKIRA).

Si procedera quindi, utilizzando i controlli "Artist Item" e "Title ltem" ad indicare quale linea debba

essere utilizzata come titolo e quale come nome artista.

utilizzando degli identificativi gia inseriti nel file: se nel file da interpretare il nome dell'artista e
il titolo del brano fossero gia contrassegnati da etichette del tipo

CurrArtist=Michael Jackson

CurrTitle=Thriller

si potra semplicemente inserire negli editors "Artist ID" e "Title ID" i due identificativi "CurrArtist=" e
"CurrTitle=" (privi di apici).
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4.3.3

Il programma quindi prowedera automaticamente ad isolare le stringhe relative a nome artista e
titolo.

In entrambi i casi, premendo il tasto "Test" si potranno fare delle prove con diverse impostazioni di
indici, separatori o identificativi.

Se viene selezionata la checkbox "lgnore if artist or title are null", verranno scartati gli elementi
che sono privi dell'uno o dell'altro campo

Questa funzione, unita al filtro delle parole, permette di evitare la visualizzazione di titoli di jingles,
sigle, basi musicali e tutto cid che non si voglia far apparire nel radiotext dinamico.

Word filter

Il filtro delle parole impedisce la Jisualizzazione, nel radiotext / PS dinamico, dei titoli che
contengano, in parte o interamente, una delle parole elencate.

Waord Filter

Mode

Whole Whord
Whole Word
Ay OCcurrence

Fault Ay OCourrence W || &dd

Enable word Filker

Le parole vanno digitate nella riga di inserimento, va quindi scelto il tipo di riconoscimento (Whole
Word o Any Occurrence). Premendo il tasto "Add", la parola verra aggiunta all'elenco.

Whole word: la parola, per essere riconosciuta, dowa essere interamente contenuta in una stringa.
Esempio, parola di filtro "mela": "mela" viene riconosciuta, "melanzana" non viene riconosciuta.
Any Occurrence: viene riconosciuta ogni occorrenza della stringa inserita
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Esempio, parola di filtro "moto": "moto" viene riconosciuta, ma anche "motocross", "motociclo” o
"terremoto”.

Il riconoscimento awiene sempre in modalita insensibile alle maiuscole/minuscole: inserire come
filtro "Test" o "TeSt" o "test", avra il medesimo effetto.

44 Schedulatore

Lo schedulatore (menu Tools->Scheduler) permette di attivare i senvizi Radiotext Plus e PSN
dinamico solo negli intervalli di tempo prestabiliti.

Scheduler, X|
@ Sun ¢ 'Mom ' Tue ' Wed . Thu ' Fri | Sak
StartTime | 0.00.00 (5 Enabled

End
23.59.59

Skart
0.00.00

Skatus
OFF

Remove

Same For all days

Clear all schedules

Si wole, ad esempio, trasmettere il Radiotext plus solo dalle 8.00 alle 12.00 e dalle 18.00 alle 23.00
di tutti i giorni, salvo la domenica dowve sara attivo per liintera giornata. Va quindi creato un ewento,
schedulato per le ore 8:00 (nell'editor "Start Time"), avente stato "Enabled" (selezionare la
checkbox). Premendo il tasto "Add", verra quindi aggiunto l'evento.
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Scheduler

00000 &

Skark End Skakus

0.00.00 8.00.00 OFF
8.00.00 23,5959 Ol

Same for all days || Clear all schedules

Ora abbiamo che dalle ore 00.00 alle ore 8.00 il coder sara disabilitato, dalle 8.00 in poi sara
abilitato. Va ora aggiunto l'evento di spegnimento alle ore 12.00, impostando 12.00 come orario
"StartTime", deselezionando la casella "Enabled" e premendo il tasto "Add".

Scheduler

120000 %

Skark End
0.00.00 5.00.00
5.00.00 12.00.00
12.00.00 23.59.59

Same for all days || Clear all schedules

Si aggiungeranno quindi gli ulteriori eventi per la riaccensione alle ore 18:00 e lo spegnimento alle

ore 23:00.

Di seguito viene indicata la programmazione ultimata.
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Scheduler

zzo000 3

Skark End

0.00.00 8.00.00

8.00.00 1Z.00.00
12.00,00 18.00.00
15.00.00 23.00,00
23.00.00 23.59.59

Same for all days || Clear all schedules

Riassumendo, si € dapprima aggiunto l'evento per l'accensione alle ore 8.00, poi l'evento per lo
spegnimento alle ore 12.00, per l'accensione alle ore 18.00 e lo spegnimento alle ore 23.00. Dato
che questa ¢ la programmazione per lintera settimana, si pud copiarla, semplicemente premendo il
tasto "Same for all days", in tutti gli altri giorni.

Scheduler
@ [~ @

zzo000 3

Skark End

0.00.00 §.00.00

§.00.00 12,00,00

12.00,00 18.00.00

18.00.00 23.00,00 Remove
23.00.00 23.59.59

Update

Same for all days || Clear all schedules

Una wolta confermata la copia in tutti i giorni settimanali, si puo verificare che, cambiando il giorno
della settimana, tutti i giorni ora contengono la stessa programmazione. Fatto cio, si pud ora
modificare il solo giorno di Domenica in cui € richiesto che I'invio sia attivo per lintera giornata.

Selezionare quindi il giorno "Sun"
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Scheduler

zzo000 3

Skark End

0.00.00 8.00.00

8.00.00 1Z.00.00
12.00,00 18.00.00
15.00.00 23.00,00
23.00.00 23.59.59

Same for all days || Clear all schedules

Premere il tasto "Clear" per rimuovere tutte le schedulazioni dal giorno corrente. Dopo aver
confermato la cancellazione della programmazione del giorno corrente, si aggiunga un unico evento,

con partenza alle ore 00:00, che abiliti l'invio.

Scheduler

Skart Skatus
0.00.00 23.99.59 OFF

Remove

Same for all days || Clear all schedules

La programmazione € completata, si pud premere il tasto "OK" per salvare la programmazione ed

uscire dalla finestra corrente.
Segue descrizione degli ulteriori controlli presenti:

Remove: rimuowe 'elemento selezionato

Update: aggiorna l'elemento selezionato con nuowe impostazioni di orario o stato abilitato/

disabilitato

Clear all schedules: elimina tutte le pianificazioni orarie in tutti i giorni.
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5

5.1

Modulo audio streaming

Il modulo a audio streaming aggiunge funzionalitd avanzate per la ricezione e la codifica di flussi
streaming, le due versioni Encoder o Decoder si adattano perfettamente alle attuali necessita di
gestire flussi audio tramite protocollo TCP/IP.

L'uscita audio viene trasferita in formato digitale al processore audio / codificatore stereo, ottenendo
cosi la massima qualita audio.

Modulo decoder

Collegare I'apparato alla rete LAN, aprire un browser web su un PC da cui & possibile accedere
all'apparato e digitare nella barra degli indirizzi del browser web: http://192.168.1.100.
Il server web interno del modulo audio dowebbe quindi caricare la pagina di accesso predefinita.

itel, pstream

Nessuna password impostata di default, cliccare sul pulsante di login per entrare nella pagina
principale.

Vai al menu "Streaming settings" e imposta uno o pitt URL da cui ricevere lo streaming audio.
Salvare la configurazione corrente premendo il pulsante "Apply settings".

MENy itel. pstream Help

0 saus Status

=J Streaming settings

Streaming Status

Streaming Status

£+ Network Settings This page displays the status of the

main and backup streams, the URL
Q System Settings of the two streams, the metadata
Main stream:Connected provided by main and backupe
streams, the status of the pre-buffers
expressed as a percentage and
audio levels of on-air source.

The on-air chain priority is MAIN
STREAM->BACKUP STREAM

@ Open Help ULy

(:) System Update

¥ Download finder software

Network Status
5] Logout
On Air stream: This page displays the network
. configurations for the ethernet
http://192.168.1.222:6001 a
interface.
L Level:-0.0dB
u System Status
3% 30 24 a8 12 &6 3 O
R Level:-0.0dB This page shows the status of the
T system and provide info about
30 24 18 12 6 3 0

firmware version, mac addresses,
st lerar (K uptime and global configuration.
o 50 100
System Log
Metadata

Shows the system activity log

© 2023 ITEL Elettronica e Telecominicazioni Snc



Modulo audio streaming 61

Il modulo decoder audio streaming consente la ricezione di streaming MP3/AAC+/HLS da seners
shoutcast mediante connettivita TCP/IP. Il modulo permette anche la riproduzione di files audio da
pendrive USB.

Per il backup audio da USB inserire una pendrive o unita di memoria Usb formattata in FAT32
contenente file audio in formato Mp3, Mp4 o Wave.

| dettagli delle impostazioni sono descritti a lato delle stesse pagine di configurazione nel webserver
integrato.

Una wolta configurato il modulo, agire sul processore audio, selezionare ora lingresso audio
"NetAudio": dowa essere possibile ascoltare lo streaming audio ricewuto dal modulo.

Regolare, se necessario, il livello di ingresso audio dell'ingresso "NetAudio”. Se si intende utilizzare
un qualsiasi processo audio durante la riproduzione da streaming, tale regolazione potra anche
essere omessa in quanto il processore prowedera al livellamento automatico. Il preset per l'ingresso
di rete si potra scegliere nella finestra successiva, una wlta selezionato I'ingresso NetAudio.

Se si desidera utilizzare piu di una fonte audio, per limpiego con il commutatore automatico
(fallback audio) interno, procedere alla selezione di questo ed impostare quindi il relativo preset.
Impostare infine la commutazione automatica degli ingressi selezionati.
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5.11

Status

Nella sezione Status é \isibile la pagina relativa alla decodifica streaming, le impostazioni di rete, le

informazioni di sistema e i log degli eventi.

Metwork Status

Streaming Status

Main stream:Connected

hitp://ice03 fluidstream.net/onedancech.my

Back stream:Disconnected

1ttp://none

On Air stream:

hittp:/fice03 fluidstream.net/onedancech.my

L Level:-0.1 dB

: u
3 ¥ M 18 L] X a
R Level:-0.1 dB
. .
L 3 4 18 & X a
Buffer Level: 74
a 50 SHTH

Metadata
Feel It - FPI Project

Streaming Status

In questa pagina vengono visualizzate le infomazioni della decodifica audio, quale URL & attualmente
in onda, i livelli audio, lo stato del buffer e la decodifica dei metadati (se presenti).

On Air Stream: Descrive quale url & attualmente decodificato, se viene visualizzato "Playlist"
significa che il player sta riproducendo i files presenti nella unita di memoria applicata alla porta USB

DRIVE posteriore.
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Streaming Status Metwork Status System Status System Log
Mode:
Fixed IP Mode
Ip Address:
Gateway:
DNS Address:

Network Status
Le impostazioni di rete sono elencate qui, la pagina degli indirizzi pud essere Visualizzata anche da
display frontale, menu System, pagina Impostazione Ethernet.

Streaming Status Metwork Status System Status System Log
Firmware:
Frontend:
Uptime:

I F Ay 14
U £ '.l\.'-'n'i.r- 15 TEULIR

Ethernet Mac Address:

GMT Offset:

System Status
La pagina contiene le informazioni relative alle versione Firmware, Mac address, area geografica e il
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contatore tempo di attivita.

Streaming Status Metwork Status System Status System Log

System Log

* [23/02/2022 10:52:38 Local] — System started

s [23/02/2022 10:54:45 Local] — Logged in from web

e [23/02/2022 10:52:38 Local]l —= System started

* [23/02/2022 10:52:38 Local]l —= System started

e [23/02/2022 10:52:38 Local] —= System started

s [23/02/2022 10:52:38 Local] —= System started

s [23/02/2022 10:53:59 Local] — Logged in from web

s [23/02/2022 10:54:12 Local] — Ethernet settings changed
* [23/02/2022 10:54:18 Local] — Main stream url changed

s [23/02/2022 10:54:18 Local] — Backup stream url changed
» [23/02/2022 10:54:20 Locall —= Main stream Disconnected
= [23/02/2022 10:54:20 Local] — Backup stream Disconnected
= [23/02/2022 10:54:25 Local] — Main stream Connected

e [23/02/2022 10:54:30 Local] —= Main stream url changed

s [23/02/2022 10:54:30 Local] —= Backup stream url changed
s [23/02/2022 10:55:01 Local] — Logged in from web

System Log
Gli eventi di sistema vengono memorizzati in modo sequenziale in questa pagina di Log dove
possono essere consultati per eventuale verifica.
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5.1.2

Streaming settings

=J Streaming settings

La sezione seguente permette di inserire gli indirizzi URL da decodificare, si puo inserire un URL
principale e uno di backup nel caso in cui dovesse interrompersi il primo.

Streaming Settings

http://streamtest.onair.it/stream1.mp3

CAcCHKUpD Sires

https://streamtest.onairit/stream2.mp3

Route Metadata to RadioText

Main Stream: Indirizzo Url streaming principale
Backup Stream: Indirizzo Url Streaming secondario o di scorta

Route Metadata to RadioText: Trasmette in RadioText il contenuto dei metadati contenuti nello
streaming verso il coder RDS (se opzione presente e se abilitato), per la gestione del coder RDS
vedere il paragrafo dedicato.

Save and apply HTTP Stream Setting: Salva le maodifiche della pagina
Reboot: Esegue il riawio del modulo stream.
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5.1.3

Network settings

- Network Settings

Nella pagina seguente si imposta il modo di connessione e gli indirizzi di rete.

Ethernet Settings () Dhcp Mode

(®) Fixed IP Mode

192.168.1.100/24

192.168.1.254

Save Ethernet Setting

Ethernet Settings:

Dhcp Mode: Modo di assegnazione automatico in presenza di server Dhcp in rete, se viene
selezionata la modalita DHCP, ogni indirizzo IP scritto nei campi sottostanti verra ignorato.

Fixed IP Mode: Modalita di impostazione di un indirizzo IP statico, I'indirizzo di rete deve essere
fornito in notazione CIDR, owero A.A.A.A / XX dove XX & la maschera di rete della rete.

Network IP Address: Indirizzo Ip assegnato al modulo stream.

Di seguito & riportata una tabella di conversione delle maschere di rete dalla notazione decimale a

CIDR.

CIDR DECIMAL

/1 128.0.0.0

/2 192.0.0.0

13 224.0.0.0

/4 240.0.0.0

/5 248.0.0.0

/6 252.0.0.0

/7 254.0.0.0

/8 255.0.0.0

/9 255.128.0.0
/10 255.192.0.0
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/11 255.224.0.0

/12 255.240.0.0

/13 255.248.0.0

/14 255.252.0.0

/15 255.254.0.0

/16 255.255.0.0

/17 255.255.128.0
/18 255.255.192.0
/19 255.255.224.0
120 255.255.240.0
121 255.255.248.0
122 255.255.252.0
123 255.255.254.0
124 255.255.255.0
/25 255.255.255.128
126 255.255.255.192
127 255.255.255.224
/28 255.255.255.240
129 255.255.255.248
/30 255.255.255.252
/31 255.255.255.254
/132 255.255.255.255

Network Gateway Address: Indirizzo Ip del gateway.

Network DNS Address: Indirizzo Ip del server di dominio.

67
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5.14

System settings

Nella pagina di sistema troviamo una stringa dove poter assegnare un nome al modulo, la gestione
della password, wolume audio, buffer e porta di comunicazione.

System Settings

Device Mame

I
i)

Save Settings Save Buffer Setting Save System Password

Device Name: identificativo apparato. E' un'etichetta caratteri a disposizione dell'utente per
identificare I'apparato.

System Password: Per proteggere il 'accesso alla pagina web dello streamer, & possibile abilitare
una password di sicurezza, digitare una password in questa riga.
Retype System Password: Ripetere la stessa password per evitare errori di digitazione

Audio Volume: Regolazione del livello di uscita generale del modulo stream verso l'ingresso audio.
Buffer Seconds: Impostazione della dimensione del buffer audio.
Gmt Offset: Selezione dell' area geografica
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Tunnel Port: Impostazione della porta di comunicazione dati per software di controllo Processor
Programmer.

Save Settings: memorizza le impostazioni del volume audio, Offset GMT, e tunnel Port

Save Buffer Settings: Salva le modifiche al Buffer, questa operazione ferma per pochi secondi lo
streaming.

Save System Password: Salva le modifiche alla password di sistema, se viene inserita verra
chiesta nella pagina di Login, se vengono lasciati wioti i campi "System password" e "Retype
System Password" non verra richiesta alla pagina Login.

5.1.5 System update

f:,; System Update

Il modulo stream pud essere aggiornato tramite questa pagina.

Upload file
| Scegli file | Messun file selezionato

| Do Update |

Una wolta ottenuto il file upgrade dal sito www.itel.it, per awiare la procedura di aggiornamento
premere "Scegli File" e cercare all'interno del proprio Pc il file scaricato. Una wlta selezionato il
nome del file viene \Visualizzato, premere "Do Update per awiare la procedura di aggiornamento,
attendere che il modulo si riawii, dopo circa un minuto aggiornare la pagina.
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5.1.6 Finder software

¥ Download finder software

Tramite il tasto Download Finder Software si puo scaricare l'utility software utile a trovare l'indirizzo ip
del modulo stream. Se l'indirizzo del modulo fosse sconosciuto, connettere l'apparato direttamente
ad un PC ed utilizzare I'utility scaricata "lpStream_Finder.exe" per recuperare l'indirizzo IP.

ﬂ Itel Ipstream Finder

| Find Streamers |

192.168.1.77: Name: Mac Ethemet: 00:08:21:08:33:97 Mac Wifi FW Version 1.7.0.2
192.168.1.58: Name: Mac Ethemet: 00:57£9:08:33:97 Mac Wifi FW .Version 1.7.0.2
152.168.1.52: Name: Mac Ethemet: 9¢:56:8e :08:33:57 Mac Wifi FW Version 1.7.0.2
152.168.1.100: Name: Mac Bthemet: 00:08:21:08:33:57 Mac Wifi FW Version 1.7.0.2
192.168.1.59: Name: Test_188 Mac Bthemet: c6:5719:5¢c:56:8e Mac Wifi FW Version 1.4.1-K-TMS
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5.2

5.3

Modulo encoder
| _HOME | CONFIGURATION | STATUS | DEFAULTS | upDATE | REBOOT |  MAC: 000BEID/A7:95 FWD40s |

itel
Stream Streaming Mode send always Help
Fomat NPEG1 43 iz Listen Online
Click the link to get the online Shoutcast stream of the
Audio Peak Left 10 dF T B N B Instreamer (as M3U playlist) to play on your PC. For proper
Input Peak Right Bl ——— :';I:;;:lsinn make sure you configure MP3 encoding and send
Status ENCODING E
Active Connections

Lists all active TCP and BRTP connections o the Instreamer.
All TCP connections are listed. That includes web page
access, Internet radios, raw TCP. Shoutcast and Icecast
connections. A TCP connection is listed if and only if it's in the
"established” state.

Stream
Streaming Mode

+ "send always® - the device streams permanently

» "send on CTS"- the device streams if CTS input on
RS-232 interface is activated

= "send on I/O" - the device streams if the selacted digital
input is activated

« "send on level” - the device straams if the input audio
peak reaches the configured level

Audio Format
Displays the current streaming format and sampling
frequency.

Audio Input

Peak Left and Right

The numbers [in dB full-scale] and the graphical VU meters
show the peak values of the analeg audio inputs (line or
microphone)

Max. value is 0 dB.

Il modulo encoder audio streaming ha il compito di generare un flusso streaming in rete IP, vari
formati di codifica consentono la trasmissione in rete dell' audio generato dal processore, verso
serners shoutcast/icecast, anche in bassa latenza, mediante protocollo RTP, UDP, Multicast o
connettivita TCP/IP.

Disponibili i seguenti codec:

e MP3 fino a 320kbps, (VBR e CBR),

¢ PCM 16bit @8, 16, 22.05, 24, 32, 44.1, 48 kHz
e G.711, uLaw, aLaw

| dettagli delle impostazioni sono descritti a lato delle stesse pagine di configurazione nel webserver
integrato

Installazione rapida

Lindirizzo IP di default &€ 192.168.1.100. Connettersi al modulo mediante un browser internet
digitando nella barra degli indirizzi: http://192.168.1.100.

Se lindirizzo del modulo fosse sconosciuto, connettere I'apparato direttamente ad un PC ed
utilizzare I'utility fornita "module_finder.exe" per recuperare l'indirizzo IP.

Andare nella sezione "CONFIG" ed Impostare uno o piu URL per gli stream da cui ricewvere il flusso
audio. Salvare mediante il tasto "SAVE & REBOOT", attendere il riawio del modulo. Configurare le
impostazioni di rete del modulo : SETUP -> NETWORK. Salvare mediante il tasto "SAVE &
REBOOQOT", attendere il riawio del modulo.

© 2023 ITEL Elettronica e Telecominicazioni Snc


http://192.168.1.100

	Introduzione
	Revisioni
	Avvertenze
	Pannello frontale
	Pannello posteriore
	Navigazione ed editing

	Funzionalità display
	Processore Audio
	Livelli di compressione
	AGC
	Caricamento preset
	Salvataggio preset
	Regolazione livello gate e drive
	Bypass

	Regolazione livello di compressione e tempo di rilascio
	Regolazione link ed equalizzazione bande
	Equalizzatore parametrico toni bassi
	Impostazioni clipper/limiter bassi
	Impostazione stereo expander

	Coder RDS
	Livelli e flags RDS
	Codice PI e PTY
	Monitor PS e Radiotext
	Impostazione PS
	Radiotext
	Liste AF

	Regolazioni ingresso audio
	Regolazione e visualizzazione livelli audio
	Selezione canale di ingresso
	Impostazione processo audio
	Impostazioni fallback (audio backup)

	Regolazioni uscita audio
	Regolazione livelli di uscita

	Regolazioni uscita MPX
	Modulazione MPX e impostazione livelllo pilota
	Impostazioni livello uscita

	Impostazioni sistema
	Display, Presets Dipendenti, ID stazione
	GPI e opzione Split
	Impostazione password
	Impostazione Ethernet
	Info Sistema
	Opzioni
	Sicurezza

	Volume Cuffie

	Software di programmazione
	Finestra principale
	Processor Params
	Presets
	Audio Ingresso Uscita
	Impostazioni di sistema

	Salvataggio - caricamento preset da file
	Salvataggio - caricamento configurazione di sistema da file
	RDS
	Finestra flags
	Finestra PS
	Finestra radiotext
	Finestra AF List
	Editing
	Metodo A
	Metodo B

	Salvataggio - caricamento profili da file

	Impostazione Password

	RD Link
	Radiotext Plus
	Monitor
	Configurazione
	Setup
	Program ID
	Radiotext Plus e PSN dinamico
	TA - Clock time
	Interfaccia di comunicazione e impostazioni aggiuntive

	Raw Text Importer
	Word filter

	Schedulatore

	Modulo audio streaming
	Modulo decoder
	Status
	Streaming settings
	Network settings
	System settings
	System update
	Finder software

	Modulo encoder
	Installazione rapida


